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PREFACE 
 
This guide describes how to use the STEP File Analyzer, a software tool that analyzes and generates a 
spreadsheet or a set of CSV (comma-separated value) files from a STEP (STandard for the Exchange of 
Product model data) file.  The spreadsheets simplify inspecting information in the STEP file at an entity 
and attribute level.  STEP files can also be checked for conformance to recommended practices for 
Product and Manufacturing Information (PMI) representation, PMI presentation, and validation 
properties. 
 
The STEP File Analyzer also generates visualizations of PMI annotations, parts modeled with tessellated 
geometry, and finite element models.   
 
More information about the STEP File Analyzer and sample spreadsheets and visualizations can be found 
at https://www.nist.gov/services-resources/software/step-file-analyzer.  The source code for the STEP File  
Analyzer is available at https://github.com/usnistgov/SFA.  
 
The STEP File Analyzer is developed as part of the Digital Thread for Smart Manufacturing project in the 
Engineering Laboratory’s Smart Manufacturing Operations Planning and Control Program (SMOPAC).  
The software was first released in 2012.  This guide is based on version 2.34 of the software. 
 
DISCLAIMERS 
 
The STEP File Analyzer might not be up-to-date with the most recent recommended practices specified 
by the CAx Implementor’s Forum.  The software might also not check STEP files for conformance to 
every aspect of a recommended practice.  Items modeled with tessellated geometry in a STEP file might 
have the wrong position and orientation in a STEP File Analyzer visualization. 
 
Any mention of commercial products in the STEP File Analyzer and this user’s guide is for information 
purposes only; it does not imply recommendation or endorsement by the National Institute of Standards 
and Technology (NIST).  For any of the web links in the software and this user’s guide, NIST does not 
necessarily endorse the views expressed, or concur with the facts presented on those web sites. 
 
This software was developed at NIST by employees of the Federal Government in the course of their 
official duties. Pursuant to Title 17 Section 105 of the United States Code this software is not subject to 
copyright protection and is in the public domain. This software is an experimental system.  The STEP File 
Analyzer also provides links to several sources of example STEP files.  NIST assumes no responsibility 
whatsoever for the use of the software and example STEP files by other parties, and makes no guarantees, 
expressed or implied, about its quality, reliability, or any other characteristic. 
   
This software can be redistributed and/or modified freely provided that any derivative works bear some 
notice that they are derived from it, and any modified versions bear some notice that they have been 
modified.  We would appreciate acknowledgement if the software is used.  
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1 Introduction 
 
This guide describes how to use the STEP File Analyzer [1], a software tool that analyzes and generates a 
spreadsheet or a set of CSV (comma-separated value) files from a STEP (ISO 10303 – informally known 
as the STandard for Exchange of Product model data) [2-4] file.  The spreadsheets or CSV files simplify 
inspecting information from the STEP file at an entity and attribute level.  In this report a “STEP file” 
refers to a file that is exported by CAD (Computer-Aided Design) software in a format described by ISO 
10303-21 and typically known as a Part 21 file [5]. 
 
Typical STEP file viewers show a 3D visualization of the part or model represented by the STEP file.  
The viewers usually have a high-level hierarchical display of the information in the STEP file where you 
can drill down to individual attributes of parts.  However, there is no way to view all of the actual STEP 
entities and their attributes at once.  The STEP File Analyzer provides this capability by creating a 
spreadsheet from the STEP file.  The STEP File Analyzer can also be used as a viewer for PMI 
annotations, parts modeled with tessellated geometry, and finite element models. 
 
The STEP File Analyzer also checks for conformance to recommended practices for PMI (Product and 
Manufacturing Information) representation, PMI presentation, and validation properties [6].  
Recommended practices are defined by the CAx Implementor Forum (CAx-IF) [7, 8].  The objective of 
the CAx-IF is to advance CAx (mainly Computer-Aided Design, Engineering, and Manufacturing) 
software system translator development and to ensure that user requirements for interoperability are 
satisfied.  PMI may include geometric dimensions and tolerances (GD&T), 3D text annotations, surface 
finish, and material specifications.  PMI representation (also known as semantic PMI) includes all 
information necessary to represent GD&T without any graphical presentation elements, although an 
importing CAD system can attempt to recreate the visual presentation of the annotation.  PMI 
presentation (also known as graphical PMI) presents GD&T annotations as a visual representation of 
geometric elements such as lines and arcs as part of the CAD model.  The validation properties include 
geometric, PMI, assembly, annotation, attribute, and tessellated validation properties.   
 
The STEP File Analyzer supports current and some older versions of the following STEP Application 
Protocols (AP).  An AP is the implementable part of ISO 10303 upon which translators STEP translator 
to and from CAD systems are based for a particular engineering domain. 
 

• AP203 – Configuration Controlled 3D Design of Mechanical Parts and Assemblies [9] 
• AP209 – Multidisciplinary Analysis and Design [10, 11] 
• AP210 – Electronic Assembly Interconnect and Packaging Design [12] 
• AP214 – Automotive Design [13] 
• AP238 – Integrated CNC Schema [14, 15] 
• AP242 – Managed Model Based 3D Engineering [16-18] 

 
IFC (Industry Foundation Classes) [19-21] and CIS/2 (CIMsteel Integration Standards) [22, 23], used in 
the building and structural steel industries, respectively, are also supported.  A complete list of supported 
APs can be found in the Help menu under Supported STEP APs (section 4.1.3). 
 
The STEP File Analyzer does not do general syntax and structure conformance testing [24].  It only 
checks for conformance to CAx-IF Recommended Practices.   
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2 Getting Started 

2.1 Installing the Software 
The STEP File Analyzer was developed for Windows computers.  The software is a 32-bit application.  
The size of the STEP file that can be translated by the software depends on the amount of computer 
memory and the options selected when running the software.  Microsoft Excel is required to generate a 
spreadsheet.  If Excel is not installed, then CSV files will be generated instead of a spreadsheet.  The 
IFCsvr toolkit is required to read STEP files (section 2.2.1). 
 
The link to the download request form for the STEP File Analyzer can be found on  
http://www.nist.gov/el/msid/infotest/step-file-analyzer.cfm.  You will receive instructions about where to 
download and install the software after submitting the download request.  The software is downloaded as 
a zip file named sfa.zip. 
 
The installation process does not require anything more than unzipping sfa.zip, which contains four files: 
 

1. STEP-File-Analyzer.exe – STEP File Analyzer graphical user interface (GUI) version 
2. STEP-File-Analyzer-CL.exe – STEP File Analyzer command-line version (section 10) 
3. SFA-Users-Guide.pdf – This user’s guide 
4. SFA-README-FIRST.pdf – A readme file 

 
There are no restrictions as to where the files are located on your computer’s file system. 

2.2 Running the Software 
To run the STEP File Analyzer, simply double click on the icon for STEP-File-Analyzer.exe.  Several setup 
functions are performed the first time you run the software: 
 

1. The What’s New information is shown in the Status tab. 
2. The Disclaimers dialog is opened. 
3. This User’s Guide is opened. 
4. You are asked if a shortcut to the STEP File Analyzer can be created in the Start Menu and if an 

icon for the software can be placed on the Desktop. 
5. The Crash Recovery dialog is opened (section 2.4). 
6. A file STEP-File-Analyzer-options.dat is created in your home directory that stores the current 

state of the STEP File Analyzer options.  Do not edit this file. 
7. The installation for the IFCsvr toolkit is automatically started (next section). 
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2.2.1 Installing the IFCsvr toolkit 
 
The IFCsvr toolkit [25] is used to read and process STEP files. The IFCsvr installation program is 
automatically started.  You might need administrator privileges to install the toolkit.  The installation 
program might cause antivirus software to respond that there is an issue with the toolkit.  The toolkit is 
safe to install.  For example, if the Windows Defender antivirus software responds that there is an issue 
with the toolkit, select More Info and Run Anyway.   
 
Two of several installation dialogs are shown in Figure 1.  Use the default installation folder as shown in 
the right dialog.  You must let the installation process complete before processing any STEP files with the 
STEP File Analyzer.   
 
Although the IFCsvr toolkit was originally written to process IFC files [19] used in the building and 
construction industry, it has been adapted to work with STEP files. 
 

 

  
 

Figure 1: IFCsvr installation dialogs 
 

2.3 Generating a Spreadsheet or CSV Files 
After the IFCsvr toolkit is installed, you can generate a spreadsheet or CSV files from a STEP file that 
uses a supported AP.  In the Options tab (section 4.4) select the Output Format as Excel or CSV.  Go to 
the File menu, select Open STEP File(s), select a STEP file on your computer, click Open in the dialog, 
and then click on the Generate Spreadsheet or Generate CSV Files button.   
 
Feedback will appear in the Status tab indicating the progress of processing the STEP file.  The 
spreadsheet will be opened after it has been generated or the directory where the CSV files were 
generated will be opened.  One CSV file is generated for each entity type.  Some features are not 
available with CSV files such as Reports (section 5) and Inverse Relationship (section 4.4.5).  The focus 
of this document is on the features related to generating spreadsheets. 
 
The first time a STEP file is processed, STEP schema files are also installed. 
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2.4 Recovering from a Crash 
Sometimes the STEP File Analyzer will unexpectedly stop (crash) when processing a STEP file.  This is 
usually due to either bugs in the STEP file or limitations of the IFCsvr toolkit.  If this happens, simply 
restart the software and process the same STEP file again by using function key F1 or F4 if processing 
multiple STEP files.  The software might also crash when processing very large STEP files.  Figure 2 
shows a dialog that is opened the first few times the software is run. 
 
The STEP File Analyzer keeps track of which entity type caused the crash for a particular STEP file and 
will not process that type again.  More details about recovering from a crash are explained in section 9.  
 

 
 

Figure 2: What to do if the STEP File Analyzer crashes 
 

2.5 Uninstalling the Software 
The STEP File Analyzer can be uninstalled by manually deleting the two executable files and PDF files, 
the STEP-File-Analyzer-options.dat file in your home directory, and the desktop icon for the software.  
The IFCsvr toolkit can also be deleted via the Control Panel.  Temporary files can also be deleted from 
C:/Users/username/AppData/Local/Temp/SFA.    
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3 Sample Worksheets 
 
The spreadsheet generated by the STEP File Analyzer contains several worksheets.  There are Summary 
and Header worksheets, along with a worksheet for each entity type that was processed from the STEP 
file.  The type of entities processed depends on the entities selected in the Process section of the Options 
tab.  Links to sample worksheets are in the Examples menu (section 4.1.3).  

3.1 Summary Worksheet 
A Summary worksheet is shown in Figure 3.  Rows 1-6 contain basic information about the STEP file 
including a link to documentation for the schema (AP214) used in the file.  Starting with row 9, each row 
in column A is the name of an entity processed from the STEP file.  The entity names are linked to their 
corresponding worksheet.  Column B is the number of each entity type.   
 

 
 

Figure 3: Summary worksheet 
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At the bottom of the spreadsheet are tabs for the Summary, Header, and many entity worksheets.  Entities 
in column A and in the worksheet tabs are grouped and colored according to the categories of entities in 
the Process section of the Options tab described in section 4.4.2.  Selecting a tab, using the links in 
column A, or using the Control-PageUp and Control-PageDown keys will switch to a different worksheet. 

3.2 Header Worksheet 
A Header worksheet is shown in Figure 4.  Rows 3-11 contain the information in a STEP file header 
section.  Rows 1 and 2 are the STEP file name and directory. 
 

 
 

Figure 4: Header worksheet 
 

3.3 Entity Worksheets 
A datum_system entity worksheet is shown in Figure 5.  Row 1 contains the name of the entity and the 
number of entities.  It is also a link back to the Summary worksheet.  Row 3 is the names of the entity 
attributes.  Column A is the entity ID. 
 
Starting with row 4, each row contains the attribute values for an entity.  Column B is the text string for 
the name attribute.  Column C is the description attribute which is blank.  Column D is the of_shape 
attribute where, in this example, all of the values for the entities are product_definition_shape 56.  This 
means that the of_shape attribute is a reference to the product_definition_shape entity with an ID of 56.  
In column F, the constituents attribute refers to either single or multiple datum_reference_compartment 
entities.  The number in parentheses is the number of entity references and the numbers after the entity 
name are the entity IDs that are referenced. 
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Figure 5: Entity worksheet (datum_system) 
 

In the draughting_model entity worksheet, shown in Figure 6, cells C4 and C6 refer to multiple entity 
types.  Cell C5 refers to multiple styled_item entities, however, the entity IDs are not shown because 
there are too many entity IDs to fit in one worksheet cell. 
 

 
 

Figure 6: Entity worksheet (draughting_model) 
 
 

3.3.1 Skipped Attributes 
 
Sometimes the STEP File Analyzer skips certain entity attributes due to limitations of the IFCsvr toolkit.  
A message about skipping an entity attribute will be shown in the Status tab and question marks are 
shown in the worksheet.  Figure 7 shows question marks (???) in column E where the control_points_list 
attributes were skipped. 
 

 
 

Figure 7: Entity worksheet (b_spline_surface_with_knots) 
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4 User Interface 
 
Figure 8 shows the STEP File Analyzer user interface running on a Windows 10 computer.  At the top of 
the user interface is the Menu bar with the File, Websites, Examples, and Help menus.  Below that is the 
Tabs bar with tabs for Status, Options, and Spreadsheet.  Below that is the Status window that shows text 
feedback when the STEP File Analyzer is running.  Clicking on the Options and Spreadsheet tabs will 
switch to the user interface for those tabs.  At the bottom of the user interface is the Generate Spreadsheet 
button, NIST logo, and Progress bar. 
 

 
 

Figure 8: User interface  
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4.1 Menu Bar 
The menu bar contains four items: File, Websites, Examples, and Help menus. 
 
4.1.1 File Menu 
 
From the File menu, shown in Figure 9, you can select a single STEP Part 21 file to process with  
Open STEP File(s).   STEP files with extensions of .stp, .step, and .p21 are recognized.  Compressed STEP 
files with an extension of .stpZ are also recognized.  Only STEP files using the supported APs can be 
processed (section 4.1.4).  The ANCHOR, REFERENCE, and SIGNATURE data sections of ISO 10303 
Part 21 Edition 3 files are also supported [5, 26].    
 
Multiple STEP files can be processed at one time by selecting the Open Multiple STEP Files in a Directory 
option where you will be asked to select a directory to search for STEP files.  The search for multiple files 
can be restricted to only the selected directory or to include all subdirectories.   
 
Multiple STEP files can also be selected in the Open STEP File(s) dialog by holding down the control or 
shift key when selecting files.  When spreadsheets from multiple STEP files are generated, a File 
Summary spreadsheet is also generated as is described in section 6. 
 
Below the first solid line in the File menu is a list of up to 20 of the most recently translated STEP files 
that can be opened directly.  Several function keys can be used to access features of the File menu and in 
the software. 
   

• F1 generates a spreadsheet from the STEP file that is first in the list.   
• F2 opens the last spreadsheet that was generated.   
• F3 opens the last File Summary spreadsheet when multiple STEP files were processed.   
• F4 generates multiple spreadsheets from the last selected directory of STEP files. 
• F5 and F6 decrease and increase, respectively, the size of the text in the Status tab. 
• F7 opens the last visualization file that was generated. 

 
 

 
 

Figure 9: File menu 
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4.1.2 Websites Menu 
 
The Websites menu, shown in Figure 10, provides links to useful resources related to the STEP File 
Analyzer, NIST research, CAx-IF resources, STEP projects, STEP EXPRESS schema documentation, 
and organizations that are programmatically related to STEP. 
 
4.1.3 Examples Menu 
 
The Examples menu, shown in Figure 11, has links to several sources of example STEP files and sample 
spreadsheets and visualizations generated by the STEP File Analyzer. 
 

 
 

Figure 10: Websites menu 
 
 
 

 
 

Figure 11: Examples menu 
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4.1.4 Help Menu 
 
The Help Menu, shown in Figure 12, has six sections.  In the first section,    
 

• User’s Guide (pdf) is a link to this document.   
• What’s New shows information in the Status tab about new features in the software.  This 

information is automatically shown every time a new version of the software is run. 
• Supported STEP APs lists all of the STEP Application Protocols (AP) and other schemas that are 

supported by the software. 
• Check for Update opens up a web page that checks for the latest version of the STEP File 

Analyzer.  Follow the instructions on that web page to download a new version of the software if 
one is available.  This feature runs automatically if an update hasn’t been checked for in the last 
30 days. 

 
The other topics in the Help menu show information in the Status tab and are similar to most information 
in this User’s Guide.   
 

 
 

Figure 12: Help menu 
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Help is also available in the form of tooltips related to some of options in the tabs.  Holding the mouse 
over any text in a tab for a second or two will show a tooltip.  The AP242 tooltip help in the Options tab 
is shown in Figure 13.  Features of the software that are not described in this User’s Guide are explained 
in the Help menu topics or in tooltips. 
 

 
 

Figure 13: Tooltip help 
 

4.2 Tabs Bar 
The Tabs bar is located directly below the menu bar in Figure 8.  Clicking on a tab will switch from the 
current tab to the selected tab.  Except for the Status tab, the tabs contain the options that affect how a 
spreadsheet is generated from a STEP file.  The options in the Options and Spreadsheet tabs are described 
in sections 4.4 and 4.5. 

4.3 Status Tab 
The Status tab shows important feedback during the generation of a spreadsheet from a STEP file.  You 
should not ignore the feedback as it provides useful information related to the success in processing the 
STEP file.  Some of the error, warning, or informational messages in the Status tab have a yellow 
background, red background, red, blue, or green text.  Syntax error messages (section 5.4) highlighted 
with a red background are for nonconformance of some aspect of the STEP file to a CAx-IF 
recommended practice [8].  Information in the Status tab is shown in Figure 8.   
 
The following general sequence of status messages appears in the Status tab when a STEP file is 
processed: 
 

• Messages about Opening STEP file and Number of entities 
o The time to complete this step depends on the size of the STEP file 

• Message about Generating Header worksheet and information from the STEP file header section 
• STEP entities listed in the order they are processed 

o The number in parentheses is the number of entities of that type in the STEP file 
o The types of entities processed depends on the entities selected in the Process section of 

the Options tab (section 4.4.2) 
• Possible messages about inverse relationships (section 4.4.5), checking recommended practices 

(section 5), and syntax errors 
• Messages about Generating Summary worksheet, Formatting Worksheets, and Processing time 
• Messages about Saving and Opening the spreadsheet 

 

______________________________________________________________________________________________________ 
This publication is available free of charge from

: https://doi.org/10.6028/N
IS

T.A
M

S
.200-4



 

       13 

4.4 Options Tab 
Figure 14 shows the Options tab that enables you to control which entities from the STEP file are written 
to the spreadsheet, to add supplemental reports to some worksheets, and to generate visualizations. 
 

 
 

Figure 14: Options tab 
 

4.4.1 Output Format 
 
Information in a STEP file can be output to a spreadsheet or set of CSV files.  Use the Visualization Only 
option to only generate visualizations (section 4.4.4) without generating a spreadsheet or CSV files. 
 
4.4.2 Selectively Process Entity Types 
 
The STEP File Analyzer can process any entity type for any schema listed by Supported STEP APs in the 
Help menu (section 4.1.4).  The checkboxes in the Process section of the Options tab allow you to 
selectively process different types of entities.  Each checkbox corresponds to a category of entities.  All 
entities unique to APs and schemas other than AP203, AP214, and AP242 are always processed. 
 
As a convenience, several buttons are available to quickly select, the correct entities to process, reports, or 
visualizations. 
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• All selects all categories except Composite, Kinematics, Geometry, and Cartesian Point.   
• None deselects all categories, except for Common, and all reports and visualizations.  
• For Reports selects all Report options and associated entity categories.   
• For Visualizations selects all Visualize options and associated entity categories. 

 
Selecting any Report automatically includes the necessary entity categories related to that report.  For 
example, selecting the report for PMI Representation automatically selects the entity categories for 
Representation, Tolerance, Shape Aspect, and AP242 and disables deselecting them. 
 
By processing only certain types of entities, the size of and time to generate a spreadsheet can be reduced.  
The categories of entities are also used to order and color the entity names on the Summary worksheet 
and tabs for the entity worksheets as shown in Figure 3.  Each category of entities is assigned a different 
color and within each category the entities are listed in alphabetic order. 
 
Holding your mouse over some of the checkboxes for a second or two will show a tooltip that lists all of 
the entities in that category.  The tooltip for the Tolerance entities is shown in Figure 15 and specifies that 
there are 64 entities in the Tolerance category.  Some of the categories contain hundreds of entities and 
the associated tooltip might not fit on the screen. 
 
A User-Defined List can also be used to set which entities will be processed.  The list is defined in a plain 
text file with the name of one entity type per line in lower case.  When the User-Defined List option is 
selected, the Browse button will be activated to select the file that contains the list of entities.  This option 
allows you more control to process only the required entity types.  It is also useful when processing large 
STEP files that might crash the software. 
 

 
 

Figure 15: Tooltip help for Tolerance entities 
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4.4.3 Reports for Recommended Practices 
 
Recommended practices are specifications that provide common implementation guidance associated 
with specific functionalities for data exchange.  The CAx-IF has published recommended practices for 
communicating PMI representation, PMI presentation, and validation properties in STEP files [8].  
Recommended practices are not part of ISO 10303.   
 
The STEP File Analyzer checks the STEP file for conformance to those recommended practices.  Details 
about entity attribute values that specify conformance are reported on various worksheets.  Non-
conformance is shown with messages in the Status tab and spreadsheet cells that are highlighted in red. 
 
Section 5.1 discusses the report for PMI representation.  Section 5.2 discusses the report for PMI 
presentation.  Section 5.3 discusses the report for validation properties. 
 
4.4.4 Visualize Options 
 
Visualizations for graphical PMI annotations, tessellated part geometry, and AP209 finite element models 
can be generated by selecting the corresponding option in the Options tab.  The graphics are visualized 
with an X3DOM file [27] that can be viewed in any web browser.  Section 6 describes the three 
visualization options. 
 
4.4.5 Inverse Relationships and Used In 
 
In a STEP schema, an entity attribute whose value consists of entity references, in which the referenced 
entity has attributes referring to the referencing attribute’s entity is called an inverse attribute.  This 
establishes an inverse relationship [28].  Inverse relationships are explicitly defined in a STEP schema 
and reporting of some of those relationships has been implemented in the STEP File Analyzer.  
 
Figure 16 is an entity worksheet for shape_aspect_relationship that shows the entity relationships 
established between the attribute values for relating_shape_aspect and related_shape_aspect in columns 
D and E.    
 

 
 

Figure 16: Entity worksheet (shape_aspect_relationship) 
 
Figure 17 and Figure 18 show how inverse relationships are shown on the datum entity based on 
shape_aspect_relationship shown in Figure 16.  Column G shows the relationship between datum and 
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other entities.  Column H, with the Used In header, shows where datum is referred to from other entity 
attributes although not by an inverse relationship established by a STEP schema.  The tooltip in the 
Options tab for the Inverse Relationships selection shows the list of entities for which some attributes 
with Inverse and Used In relationships that are reported. 
 

 
 

Figure 17: Inverse Relationships and Used In example (columns A-F) 
 

 

 
 

Figure 18: Inverse Relationships and Used In example (columns G-H) 
 
 

4.4.6 Open STEP File in Other Applications 
 
The Open STEP File in option is a convenient way to open a STEP file in other applications.  Figure 19 
shows the pull-down menu listing some of the applications that can open a STEP file on the author’s 
computer.  The pull-down menu will always contain a text editor, Default STEP Viewer, and  
Indent STEP File (for debugging) which is described below.  The Default STEP Viewer is whichever 
application is associated with STEP files (.stp file extension).  Several STEP file viewers and 
conformance checkers also appear in the pull-down menu.  Applications will appear in the pull-down 
menu if they are installed in their default location.  To open a STEP file in one of the applications, select 
the application from the pull-down menu and click the Open button.   
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Figure 19: Open STEP File in other applications 
 
 
4.4.6.1 Indent STEP File 
 
The option to Indent STEP File will show the STEP file in a text editor; however, the STEP entities will be 
rearranged and indented to show the hierarchy of information in the STEP file.  This is a useful feature to 
help debug a STEP file, but is not recommended for large STEP files.  Figure 20 shows a sample of the 
“indented” output.  In this sample, it is easy to see how flatness_tolerance (#5584) refers to 
length_measure_with_unit (#5585) and datum_feature (#5583).  An “indented” portion of the STEP file 
starts with entities that will generate useful output and stops with other entities to prevent the “indented” 
file from getting too large.  Basic geometric entities can optionally be included in the “indented” file 
which will increase the size of the file.  The resulting “indented” file is named mystepfile.stp.txt 
 

 
Figure 20: Indented STEP file 
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4.5 Spreadsheet Tab 
 
The Spreadsheet tab, shown in Figure 21, contains several more options that affect how information is 
written to the spreadsheet. 
 

 
 

Figure 21: Spreadsheet tab 
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4.5.1 Tables 
 
Figure 22 shows the shape_aspect worksheet with the option for generating tables turned on.  With this 
option, pull-down menus (selector on the right of each cell in row 3) are shown with the column headers 
in row 3 that access functions to sort and filter the rows.  The table is sorted by the name attribute in 
column B.  This is evident by the order of the entity IDs in column A.  The worksheet containing 
validation properties (section 5.3) is always sorted.  
 

 
 

Figure 22: Entity worksheet (shape_aspect) with tables for sorting 
 
4.5.2 Number Format 
 
By default, when the STEP File Analyzer adds a single real number to a worksheet cell, Excel might 
round the number.  Figure 23, on the left, shows values of radius in column D that are rounded.  Using the 
Number Format option in the Spreadsheet tab to not round real numbers, results in the radius column is 
shown with full precision in the worksheet on the right.  The non-rounded real numbers are the actual 
values that appear in a STEP file.  The non-rounded real numbers are indicated by the small green triangle 
in the upper left corner of a cell.  The non-rounded real numbers are also left justified as opposed to the 
rounded real numbers that are right-justified.  Real numbers that appear in pairs or triplets, such as 
cartesian points, are never rounded. 
 

   
 

Figure 23: Rounding numbers example 
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4.5.3 Maximum Rows 
 
The maximum rows option in the Spreadsheet tab limits the maximum numbers of rows in any 
spreadsheet or CSV file to the selected value.  This reduces the size of the spreadsheet and speed 
processing of the STEP file.  Figure 24 shows that only the first 100 of 43681 rows for the 
cartesian_point entities are written to the worksheet.  Syntax errors (section 5.4) related to reports might 
be missed if some entities are not processed due to a small value for maximum rows. 
 

 
 

Figure 24: Maximum rows example 
 
4.5.4 Other Options 
 
The other options on the Spreadsheet tab control: 
 

• Opening the spreadsheet after or while it is being generated 
• Generating links from entity worksheets to the Summary worksheet and entity documentation 
• Generating links on the File Summary worksheet when multiple STEP files are processed 
• Specifying where to write the spreadsheet 
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5 Reports 
 
Product and manufacturing information (PMI) are annotations and attributes that define product geometry 
and product specifications [29].  PMI includes 3D annotations to specify Geometric Dimensioning and 
Tolerancing (GD&T), as well as non-geometric data such as surface texture specifications, finish 
requirements, process notes, material specifications, and welding symbols.  GD&T is a symbolic 
language used to communicate tolerances on manufactured parts.   The industry standards for presentation 
of GD&T in axonometric views in 3D space are ASME Y14.41-2003 [30] and ISO 16792:2006 [31].  
Some common tolerances include dimensional tolerances on length and diameter, and geometric 
tolerances on flatness, position, surface profile, and circular runout. 
 
Figure 25 shows a part with typical PMI annotations including dimensions, geometric and dimensional 
tolerances, and datum features.  Most of these types of annotations are processed by the STEP File 
Analyzer. 
 

 
 

Figure 25: Part with PMI annotations 
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Figure 26 shows the summary worksheet, similar to Figure 3, with entities highlighted that have 
information related to PMI Representation and PMI Presentation.  Rows 10-13 are entities related to the 
datum reference frame.  Row 14 is the dimensional_characteristic_representation entity which is 
associated with all dimensional tolerances.  Rows 9 and 17-24 are entities related to geometric tolerances.  
Row 28 is the annotation_curve_occurrence entity which is associated with PMI presentation.  The 
entity name in parentheses in cell A17 is for a complex entity 
(flatness_tolerance)(geometric_tolerance_with_defined_unit_area).  All of the worksheets for the 
highlighted entities will have additional columns with PMI information related to that type of entity.  
 

 
 

Figure 26: Summary worksheet with entities highlighted for PMI 
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5.1 PMI Representation 
PMI representation (also known as semantic PMI) includes all information necessary to represent GD&T 
without any graphical presentation elements.  PMI representation is associated with CAD model geometry 
and is computer-interpretable to facilitate automated consumption by downstream applications for 
manufacturing, measurement, inspection, and others.  PMI representation does not contain any 
information regarding its visual appearance although an importing CAD system can attempt to recreate 
the visual presentation of the annotation.  The CAx-IF defines recommended practices for PMI 
representation [32].  Syntax errors related to nonconformance to the recommended practices are 
highlighted in red in the Status tab and in the relevant entity worksheets (section 5.4). 
 
5.1.1 Visual Presentation of PMI Representation 
 
Sections 5.1.2 through 5.1.3 show three examples of how PMI representation is reported.  The report 
includes a visual presentation of the semantic PMI information that can be used for visual verification of 
that information.  The visual presentation should correspond to the expected PMI annotations similar to 
those on Figure 25.  If the visual presentation does not look right, then the semantic PMI information 
might be wrong.  The visual presentation is limited by the characters and symbols available in the 
spreadsheet.   
 
5.1.2 Datum Reference Frame Example 
 
The following figures show how a datum reference frame is modeled in a STEP file.  Figure 27 shows the 
datum worksheet that defines the datum labels in column F.   

 

 
 

Figure 27: Entity worksheet (datum) 
 
Figure 28 shows the datum_reference_compartment worksheet with information for the compartments 
of a datum reference frame.  The compartments are constructed from the base attribute that refers to the 
datum entity above and the modifiers attribute.  The visual presentation of the compartments is shown in 
column H.  The parenthetic notation in cell H3 specifies the section number in the CAx-IF recommended 
practice for PMI representation related to that information [32].   

 

 
Figure 28: Entity worksheet (datum_reference_compartment) 
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Figure 29 shows the datum_system worksheet with information to combine the datum reference 
compartments, defined by the constituents attribute, to create a datum reference frame.  The visual 
presentation of the datum reference frames is shown in column G.   
 

 
 

Figure 29: Datum reference frame example 
 

 
5.1.3 Dimensional Tolerance Example 
 
The following example shows how a dimensional tolerance is modeled in a STEP file.  Figure 30 and 
Figure 31 show the dimensional_characteristic_representation worksheet where information related to 
dimensional tolerances is reported.   
 

• Column B is the type of dimension, either dimensional_size or dimensional_location. 
• Column C is a reference to shape_dimension_representation which refers to information for the 

dimension name and value. 
• Column D shows the visual presentation of the dimensional tolerances that correspond to the PMI 

annotations in Figure 25. 
• Column E shows the name attribute of the entity type shown in column B.   
• Column F shows the dimension (length value) associated with the 

shape_dimension_representation entity in column C.   
• Column G shows the name of the length value in column F.   
• Column H shows the plus-minus bounds associated with the dimensional tolerance.  The bounds 

are defined by plus_minus_tolerance entities. 
• Column I shows the geometric entities associated with the dimensional tolerances.  In this case, 

the association is through shape_aspect entities which refer to advanced_face entities.  The 
geometry entities cylindrical_surface and plane are referred to by the advanced_face attribute 
face_geometry. 

• More columns may show other attributes of dimensional tolerances depending on the STEP file. 
 

The parenthetic notation in row 3 specifies the section number in the CAx-IF recommended practice for 
PMI representation related to that piece of information.  For example, sections 5.1.1 (column E) and 5.2.1 
(column F) in the recommended practice specify allowable attribute values shown in those columns. 
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Figure 30: Dimensional tolerance example (columns A-C) 
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The visual presentation in Figure 31 can be used to do a semantic analysis of the PMI representation 
information.  The dimension ‘0.75’ in cell I11 appears as a reference dimension ‘(.750)’ in Figure 25.  In 
this case, the STEP file is missing the dimension modifier for a reference dimension.  The visual 
presentation of the dimension shows that parentheses for a reference dimension are missing. 
 
The feature count for a repetitive dimension, e.g., ‘4X’ and ‘2X’, in cells D6 and D7, respectively, are 
derived from the number of geometric surfaces in the associated geometry in column I.  In this example, 
the feature count is half the number of cylindrical_surface entities in cells I6 and I7.  This assumes that a 
cylindrical hole is modeled with two half cylinders.  In some cases, the feature count might be off by a 
factor of two. 
 

 
 

Figure 31: Dimensional tolerance example (columns A, D-I) 
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5.1.4 Geometric Tolerance Examples 
 
The following examples show how geometric tolerances are modeled in a STEP file.  Figure 32 and 
Figure 33 show the flatness_tolerance worksheet with the reconstructed visual presentation for the 
flatness tolerance.   
 

• Column D is the magnitude of the flatness tolerance zone which is a reference to a 
length_measure_with_unit.  As a convenience, the value of the length measure “0.005” is also 
shown. 

• Column E is a reference to the toleranced shape_aspect. 
• Columns F and G define the unit-basis size and type for the flatness tolerance.  Another unit-basis 

parameter in column H is not shown. 
• Column I shows the visual presentation of the flatness tolerance with the corresponding unit-basis 

and datum feature. It corresponds to the PMI annotations in Figure 25. 
• Column J is the datum feature associated with the flatness tolerance. 
• Column K shows the toleranced geometry associated with the flatness tolerance derived from the 

toleranced_shape_aspect attribute in column E. The advanced_face entity references the plane 
entity. 

 
The reconstructed visual presentation of the PMI representation is limited by the character set available in 
the spreadsheet.  The flatness tolerance symbol (parallelogram) appears somewhat small and misshapen.  
The lines for the compartments of the feature control frame are not shown.  The combination of the 
inverted triangle, vertical line, and ‘E’ in brackets represents the reference to datum feature ‘E’. 
 

 
 

Figure 32: Flatness tolerance example (columns A-H) 
 
 

 
 

Figure 33: Flatness tolerance example (columns I-K) 
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Figure 34 and Figure 35 show the position_tolerance worksheet with the reconstructed visual 
presentations of two position tolerances. 
 

• Column D is the magnitude of the position tolerance zone.  As a convenience, the value of the 
length measure “0.005” is also shown. 

• Column E is a reference to the toleranced shape_aspect. 
• Column F is a reference to the associated datum reference frame. 
• Column G is the modifier applied to the tolerance zone. 
• Column H shows the visual presentation of the position tolerances with their associated 

dimensions.  An association between a geometric tolerance and dimension (or datum) is shown if 
each has the identical cylindrical_surface entities in the geometric tolerance Toleranced Geometry 
(Figure 35, Column J) and dimension Associated Geometry (Figure 31, cells I6 and I7).  

• Column I shows the dimensional tolerance, defined in Figure 31, associated with the position 
tolerance.  The dimensional_size entities are referred to in column B of Figure 30.    

• Column J shows the geometry, defined by the toleranced_shape_aspect attribute in column E, 
associated with the position tolerance. 

 

 
 

Figure 34: Position tolerance example (columns A-G) 
 

 
 

Figure 35: Position tolerance example (columns H-J) 
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5.1.5 PMI Representation Summary 
 
As a convenience, all of the visual presentations of the datum reference frames, dimensional tolerances, 
and geometric tolerances are collected on the PMI Representation Summary worksheet shown in Figure 
36.  The annotations in column C are collected from column G in Figure 29, column I in Figure 33, and 
column H in Figure 35.  The annotations in column C correspond to the annotations shown in Figure 25. 
 

 
 

Figure 36: PMI Representation Summary worksheet 
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The semantic association of the datum feature and dimension with a geometric tolerance is based on each 
referring to the same geometric entities (usually cylindrical_surface and plane) in the STEP file.  In 
Figure 25 datum feature ‘E’ is associated with a surface profile tolerance.  Datum feature ‘E’ is the 
surface of the tab.  However, in Figure 36, datum feature ‘E’ is associated with two geometric tolerances 
shown in cells C21 and C28.  Semantically both are correct since both tolerances refer to the same 
surface.  There is no semantic information in the STEP file to specify which tolerance the datum feature is 
presented with.   
 
If an expected association between a geometric tolerance and a dimension or datum is not reported, then 
the Associated Geometry (Figure 31) and Toleranced Geometry (Figure 35) for each tolerance, 
dimension, and datum should be checked.  A common problem is a position tolerance for a hole being 
associated with the surfaces of the hole cylinder and the corresponding hole diameter dimension only 
being associated with the circular edge of the hole. 
 
If a STEP file is processed that was generated from a NIST CAD model from the MBE PMI Validation 
and Conformance Testing Project [33] and the file can be recognized as having been generated from one 
of the CAD models, then the PMI Representation Summary worksheet is color-coded by the expected 
PMI annotations (section 7.1).  
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5.1.6 PMI Representation Coverage Analysis 
 
Coverage analysis counts the number of occurrences of a PMI element in a STEP file.  Figure 37 shows 
the worksheet that is generated for coverage analysis of PMI Representation.  Column A in rows 4 
through 52 contain different types of PMI elements related to geometric and dimensional tolerances and 
datums.  Rows 51 through 130 are not shown and contain PMI elements related to tolerance zones and 
tolerance modifiers.  The other PMI elements are shown in Figure 56 and Figure 57.  The tolerances in 
rows 4 through 18 show their associated symbol.  The numbers in parentheses refer to the sections in the 
CAx-IF recommended practice for the representation of PMI [32] where there is implementation guidance 
for that type of PMI element.  Column B contains the number of occurrences of that type of PMI element 
in the file.  Comparing the count to the number of expected PMI elements is a way to verify the PMI in 
the STEP file and resolve and modeling issues.  If a STEP file is processed that was generated from a 
NIST CAD model, then the PMI Representation Coverage worksheet is color-coded by the expected 
number of PMI elements (section 5.1.6).  
 

 
 

Figure 37: PMI Representation Coverage worksheet (rows 1-50) 
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5.2 PMI Presentation 
PMI presentation (also known as graphical PMI) presents GD&T annotations as a visual representation of 
geometric elements such as lines and arcs as part of the CAD model, i.e., how the annotation is drawn on 
the model.  PMI presentation is not intended to be computer-interpretable and does not carry any semantic 
representation information although it can be linked to its corresponding semantic representation. The 
CAx-IF defines recommended practices for PMI presentation [32].  Syntax errors related to 
nonconformance to the recommended practices are highlighted in red in the Status tab and in the relevant 
entity worksheets (section 5.4). 
   
Figure 38 through Figure 40 show how PMI presentation is reported in the spreadsheet.  The report for 
PMI presentation only contains information about the graphical elements (points, lines, colors) needed to 
draw PMI annotations.  PMI presentation information is always reported on the 
annotation_curve_occurrence (as in this example), tessellated_annotation_occurrence, or 
annotation_occurrence worksheets. 
 

• Columns B, C, and D show the entity attributes. 
• Column E shows the name attribute of the geometric_curve_set in column D.   
• Column F shows the element attributes of the geometric_curve_set.  In this case, the elements 

refer to polyline entities.   
• Column G shows the curve_style associated with the presentation_style_assignment in column 

C.   
• Column H shows the color associated with the curve_style in column G. 
• Column I shows the annotation plane associated with the annotation.   
• Column J shows the geometry that the annotation is attached to.  If associated geometry is 

missing, then there is no cross-highlighting between the annotation and geometry. 
• Column K shows the associated PMI representation entities. 
• Not shown are columns for PMI presentation validation properties (section 5.3) and Saved Views. 

 

 
 

Figure 38: PMI presentation example (columns A-D) 
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Figure 39: PMI presentation example (columns E-H) 
 

 
 

Figure 40: PMI presentation example (columns I-K) 
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5.2.1 PMI Presentation Coverage Analysis 
 

Coverage analysis counts the number of occurrences of a PMI element in a STEP file.  Figure 41 shows 
the worksheet that is generated for coverage analysis of PMI presentation.  Rows 4 through 33 of column 
A contain the recommended names [32] that can be associated with a PMI annotation.  The names 
correspond to the values in column E in Figure 39.  There is no semantic meaning associated with the 
names.  PMI presentation assumes a semantic meaning through its association with PMI representation as 
shown in column K of Figure 40.  
 

 
 

Figure 41: PMI Presentation Coverage worksheet 
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5.3 Validation Properties 
Validation properties are an important tool to verify the information in a STEP file.  For example, 
geometric validation properties are characteristics of solid and surface models, such as area, volume, and 
centroid.  Geometric validation properties could be written to a STEP file when it is exported from a CAD 
system.  When the STEP file is imported to a receiving CAD system, that system can compute the same 
validation properties and compare them to the values from the originating system in the STEP file.  If the 
computed validation properties are within an agreed tolerance to the original validation properties, then 
the exchange of geometric information has been validated. The CAx-IF defines recommended practices 
for validation properties [34].  Syntax errors related to nonconformance to the recommended practices are 
highlighted in red in the Status tab and in the relevant entity worksheets (section 5.4). 
 
Figure 42 and Figure 43 shows a validation properties report.  The report always appears on the 
property_definition worksheet.  The rows can be sorted by any of the column attributes.  The validation 
properties are shown in the yellow and green columns E, G, I, K, and M.  Row 3 contains the names of 
the type of value in those columns.  Properties not colored yellow and green are not validation properties 
as defined by the recommended practice.  The values in cells I7, I10, and I16 are cartesian coordinates.  
Empty cells E13 and E14 show that values for those attributes were not specified in the STEP file.  If no 
values for units and exponent appear in rows K and M, then none are required based on the type of value 
in row I. 
 
The hidden columns F, H, J, L, and N can be shown by clicking on the plus (+) signs above the columns 
or the “2” in the upper left corner.  Those columns contain the entity attribute name and ID for the 
corresponding validation property value in the column to the left.  Opening the hidden columns shows 
where the validation property values come from in the STEP file.  The hidden columns F, H, and J are 
shown in Figure 44.  Columns L, M, and N are not shown.  For example, the value in cell G4 “surface 
area measure” comes from the measure_representation_item name attribute of entity ID 393.  The 
expanded columns can be hidden again by clicking on the minus (-) signs above the columns or the “1” in 
the upper left corner. 
 

 
 

Figure 42: Validation properties example (columns A-D) 
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Figure 43: Validation properties example (columns E-O) 
 

 
 

Figure 44: Validation properties example with expanded columns (columns E-J) 
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5.4 Syntax Errors 
Syntax errors related to nonconformance to a CAx-IF recommended practice are highlighted in red in the 
Status tab and on the relevant entity worksheets.  Figure 45 shows two syntax errors displayed in the 
Status tab while generating the PMI Presentation report.  The second line of each syntax error refers to 
specific sections, figures, or tables in the relevant recommended practice that provides the guidance for 
the correct implementation of that information.  The second syntax error with the name attribute is 
highlighted on the associated geometric_curve_set worksheet in Figure 46. 
 

 
 

Figure 45: Syntax error shown in the Status tab 
 

 

 
 

Figure 46: Syntax error shown on a worksheet 
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6 Visualizations 
 
Visualizations for graphical PMI annotations, tessellated part geometry, and AP209 finite element models 
can be generated.  The graphics are visualized with an X3DOM file that can be viewed in any web 
browser [27].  The resulting visualization file is named mystepfile-x3dom.html.  Examples of the 
visualizations are available at https://pages.nist.gov/CAD-PMI-Testing/.  
 
6.1.1 PMI Presentation 
 
PMI presentation (graphical PMI) can be visualized by selecting the option for it in the Visualize section 
of the Options tab (section 4.4.4).  STEP AP203, AP214, and AP242 support PMI presentation.  The 
visualization file only contains the line segments or faces that are used to construct the annotation and not 
the part geometry to which it is applied.  Boundary representation (b-rep) part geometry can be view with 
STEP file viewers [35], some of which also display PMI annotations.   
  
Figure 47 is a screenshot from a web browser showing the visualization file generated from the PMI 
annotations in a STEP AP203 file.  The visualization file contains the line segments defined by the 
polylines in column F of Figure 39 and corresponds to the annotations shown in Figure 25.  In this 
example, the annotations are assigned a random color to help differentiate them from each other. 
 
To the right of the visualization is a link to the NIST CAD model test case drawing.  A toggle switch for 
the PMI associated with saved view ‘MBD_0’ is shown.  In this case, there is only one saved view for the 
PMI.  Multiple saved views will have multiple toggle switches.  There are also instructions about 
navigating the visualization.   
 

 
 

Figure 47: Visualization of PMI presentation 
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6.1.2 Tessellated Part Geometry 
 
Tessellated part geometry can be visualized by selecting the option for it in the Visualize section of the 
Options tab (section 4.4.4).  Boundary representation (b-rep) part geometry can be view with STEP file 
viewers [35].  STEP AP242 supports tessellated part geometry, but not AP203 and AP214.   
 
Figure 48 is a screenshot from a web browser showing the visualization file generated from the tessellated 
part geometry in a STEP AP242 file.  Parts in an assembly might have the wrong position and orientation 
or be missing.  The transparency slider bar can be adjusted to make the tessellated part geometry appear 
transparent, however, the transparency is only approximate due to the transparency model used in 
X3DOM.   
 

 
 

Figure 48: Visualization of tessellated part geometry 
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Figure 49 is a screenshot from a web browser showing the visualization file generated from both the 
tessellated part geometry and the PMI annotations in a STEP AP242 file. The screenshot corresponds to 
the part and annotations shown in Figure 25.  The multiple colors of the PMI annotations are the result of 
the random colors assigned to the annotations and how the annotation graphics are structured in the STEP 
file.   

 

 
 

Figure 49: Visualization of PMI annotations and tessellated part geometry 
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6.1.3 AP209 Finite Element Model 
 
The finite element model in a STEP AP209 file can be visualized by selecting the option for it in the 
Visualize section of the Options tab (section 4.4.4).  Nodes, 1D elements, 2D elements, and 3D elements 
are shown along with the finite element mesh.  Visualization of boundary conditions, loads, and results 
are not currently supported.  Figure 50 shows the finite element model of an ultra-lightweight glider [11].  
2D elements are cyan, 1D elements are magenta, nodes are blue, and the mesh is black.  To the right of 
the visualization are toggle switches for the Nodes, Mesh, and 1D and 2D Elements.  The number of 
nodes and different element types are also listed.  There might be insufficient memory for the STEP File 
Analyzer to process all of the nodes and elements for very large finite element models.    
 

 
 

Figure 50: Visualization of AP209 finite element model 
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Figure 51 shows the same finite element model without the mesh where the magenta-colored 1D elements 
are clearly visible.  The 2D elements are partially transparent.   
 

 
 

Figure 51: Visualization of AP209 finite element model, no mesh 
 

Figure 52 shows only the nodes of the same finite element model.    
 

 
 

Figure 52: Visualization of AP209 finite element model, nodes only 
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Figure 53 shows a finite element model generated from the part in Figure 25. 
 

 
 

Figure 53: Visualization of AP209 finite element model 
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7 Color-coding Results for the NIST CAD Models 
 
If a STEP file is processed that was generated from a NIST CAD model from the MBE PMI Validation 
and Conformance Testing Project [33] and the file can be recognized as having been generated from one 
of the CAD models, then the PMI Representation Summary and PMI Representation Coverage 
worksheets are color-coded by the expected PMI annotations. 

7.1 Representation Summary 
The PMI Representation Summary worksheet is color-coded by the expected PMI annotations in a NIST 
case drawing.  Figure 54 is a color-coded worksheet for a STEP AP242 file generated from CAD model 
based on NIST test case CTC 5 (https://s3.amazonaws.com/nist-
el/mfg_digitalthread/nist_ctc_05_asme1_rd.pdf).  A similar worksheet based on NIST test case CTC 3, 
without color-coding, is shown in Figure 36.  The color-coding is determined by comparing the expected 
PMI annotations for a NIST test case, that are encoded in the STEP File Analyzer, with the PMI 
Representation in column C.  The legend at the bottom of column C describes the color-coding. 
 

• Green is an exact match to a PMI annotation. 
• Cyan is a partial match. 
• Yellow is a possible match. 
• Red is no match. 

 
Some possible matches could be also considered partial matches.  For partial and possible matches, the 
best match to expected Similar PMI is shown in column D.  At the bottom of column C are the expected 
Missing PMI annotations not found in the STEP file. 
 
In this example, cell C13 is missing the diameter symbol.  The shape of the placed datum targets in cells 
C17 and C18 are incorrect.  The tolerance in cell C21 is missing the association with a datum feature. 
 
Trailing and leading zeros are ignored when matching a PMI annotation.  Matches also only consider the 
current capabilities of PMI in STEP AP242 and CAx-IF Recommended Practices.  For example, PMI 
annotation symbols for counterbore, countersink, and depth are ignored although they might appear in the 
corresponding CAD model.  Some causes of partial and possible matches are missing associations of a 
geometric tolerance with a datum feature or dimension, missing modifiers and diameter symbols, and 
incorrect feature counts for repetitive dimensions. 
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Figure 54: Color-coded PMI Representation Summary worksheet for CTC 5 
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7.2 Representation Coverage Analysis 
The PMI Representation Coverage worksheet is color-coded by the expected number of PMI elements for 
a NIST test case.  The expected number of PMI elements was determined by manually counting them in 
each test case drawing, similar to Figure 25, for the NIST test cases.  The color-coded worksheet is shown 
in Figure 55 through Figure 57.  A similar worksheet without color-coding is shown in Figure 37.   
 
If more or less than the expected number of PMI elements was found, then the first value of two is the 
number found and the second is the expected number.  For example, ‘2/3’ means that two PMI elements 
were found when three were expected.  Counting of some modifiers, e.g., maximum material condition in 
row 61, does not differentiate whether the modifier appears in the tolerance zone definition or datum 
reference frame. 
 
A legend describing the colors is in column D of Figure 55. 
 

• A green cell is a match to the expected number of PMI elements.   
• Cyan means that more were found than expected, e.g., ‘4/3’.   
• Yellow means that less were found than expected, e.g., ‘2/3’. 
• Red means that no instances of an expected PMI element were found, e.g., ‘0/3’ 
• Magenta means that some PMI elements were found when none were expected, e.g., ‘1/0’ 
• Gray means that a PMI element is in a NIST test case drawing but there is no CAx-IF 

Recommended Practice to model it. 
 

As an example of how to interpret the color-coding, a required spherical radius dimension might have 
been modeled only as a radius (not spherical) in the CAD model.  In the coverage analysis worksheet, the 
missing spherical radius would be colored red, while the extra unexpected radius would be colored 
magenta. 
 
If a test case drawing contains hole depth, counterbore, and countersink, then the cell for those is colored 
gray because there currently is no recommended practice for those PMI elements. This means that those 
types of hole dimensions are not associated with a dimension type such as diameter and radius in the 
STEP file, although the dimension value and type is still represented semantically in the CAD model.  
This does not affect the PMI presentation (graphics) for those PMI elements.   
 
In Figure 55, cell B35 is colored red because of a missing reference dimension as described in section 
5.1.3.  Cell B28 is cyan because more diameter symbols were found than expected. 
 
A cell color other than green might mean that a CAD system or translator 
 

• did not or cannot correctly create in the CAD model, a PMI element defined in a NIST test case, 
• did not follow CAx-IF Recommended Practices for PMI [32], 
• has not implemented exporting a PMI element to a STEP file, or 
• mapped an internal PMI element to the wrong STEP PMI element. 
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Figure 55: Color-coded PMI Representation Coverage worksheet (rows 1-50) 
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Figure 56: Color-coded PMI Representation Coverage worksheet (rows 51-100) 

______________________________________________________________________________________________________ 
This publication is available free of charge from

: https://doi.org/10.6028/N
IS

T.A
M

S
.200-4



 

       49 

 
 

Figure 57: PMI Representation Coverage worksheet (rows 101-130) 
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8 Processing Multiple STEP Files 
 
Processing multiple STEP files at once is an easy way to process many STEP files with only a few mouse 
clicks and to compare entity usage and coverage of PMI representation and presentation across multiple 
STEP files. 
 
There are two ways you can select multiple STEP files.  The first is to use the  
Open Multiple STEP Files in a Directory option from the File menu as shown in Figure 9.  You can select a 
directory in which all STEP files in that directory will be processed.  Subdirectories of the selected 
directory can also be searched.  The other way is to select multiple individual STEP files when using the 
Open STEP File(s) option from the File menu.  Multiple STEP files can be selected in the Open File(s) 
dialog by holding down the control or shift key when selecting files. 

8.1 Summary Worksheet 
When processing multiple STEP files a second spreadsheet is generated, in addition to the individual 
spreadsheets for each STEP file.  The second spreadsheet contains a summary worksheet of the entities 
found in the multiple files and possible coverage worksheets for PMI representation and presentation as 
shown in Figure 58.  In this example five STEP files were processed.  Starting after row 9, column A lists 
all of the entity types in all five files.  All of the entities are not shown.  The entities in column A are 
grouped and colored according to the categories of entities in the Process section of the Options tab as 
described in section 4.4.2.  Columns B through F contain the entity counts for each of the five STEP files.  
Column G is the total entity count for all of the files and column H is the total number of files that an 
entity appears in. 
 
Row 1 is the top-level directory where all of the STEP files are located.  Row 3 contains links to the 
individual spreadsheets.  Row 4 contains the name of the STEP file and a link to it.  The file name can 
also contain the file’s subdirectory.  Clicking on the STEP file link will shown it in whatever program is 
registered to open STEP files on your computer.  The links in rows 3 and 4 can be turned off in the 
Spreadsheet tab with the selections for Excel Options.  Rows 5 through 9 contain, respectively, the file 
timestamp, software that generated the STEP file (blank in this example), the STEP AP from the file, the 
size of the STEP file, and the number of entities in the STEP file. 
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Figure 58: File Summary worksheet, multiple files (rows 31-56) 
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8.2 Coverage Analysis Worksheets 
If PMI representation or presentation is found in the STEP file, then coverage analysis worksheets are 
generated.   
 
8.2.1 PMI Representation Coverage Analysis 
 
Figure 59 through Figure 62 show the worksheet that is generated for coverage analysis of PMI 
representation.  The information on the worksheet is the same as described in section 5.1.6.  Columns B 
through F refer to five STEP files and contain the number of occurrences of that PMI element.  Column G 
counts the total number of occurrences for all STEP files that contain that type of PMI element.  In this 
example the cells are color-coded, as described in section 5.1.6, because all five STEP files were 
generated from the NIST CAD models. 
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Figure 59: PMI Representation Coverage worksheet, multiple files (rows 1-41) 
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Figure 60: PMI Representation Coverage worksheet, multiple files (rows 42-79) 
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Figure 61: PMI Representation Coverage worksheet, multiple files (rows 80-117) 
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Figure 62: PMI Representation Coverage worksheet, multiple files (rows 118-130) 
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8.2.2 PMI Presentation Coverage Analysis 
 
Figure 63 shows the worksheet that is generated for coverage analysis of PMI presentation.  The 
information in the worksheet is the same as described in section 5.2.1.  Columns B through F refer to five 
STEP files and contain the number of occurrences of that PMI presentation name.  Column G counts the 
total number of occurrences for all STEP files that contain that name.   
 

 
 

Figure 63: PMI Presentation Coverage worksheet, multiple files  
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9 Crash Recovery 
 
As explained in section 2.4, sometimes the STEP File Analyzer will crash when processing a STEP file.  
This is most likely due to either syntax errors in the STEP file or due to limitations of the IFCsvr toolkit 
(section 2.2.1).  If a crash occurs, one or more of the dialogs in Figure 64 might be shown.  If this 
happens, simply close the dialog(s), restart the software, and process the same STEP file again by using 
function key F1 or F4 if processing multiple files.  The software keeps track of which entity type caused 
the crash for a particular STEP file and won’t process that type again.  A message will be shown in the 
Status tab if a particular type of entity won’t be processed.   
 
The entity types that won’t be processed again are stored in a file *-skip.dat where ‘*’ is the name of the 
STEP file.  No matter what the reason is for the crash, that file will always be generated.  Even if you stop 
the STEP File Analyzer in the middle of processing a STEP file, the file *-skip.dat will be generated.  
Therefore, the next time the software is run, the entity type that was being processed when you stopped 
the software will not be processed.  In this case, or if the syntax errors related to the bad entity are 
corrected, the *-skip.dat file can be deleted or edited. 
 

 
 

 
 

Figure 64: Dialogs displayed when the software crashes 
 
The software might also crash when processing very large STEP files.  Popup dialogs might appear that 
say “unable to alloc xxx bytes”.  In this case, deselect some entity types to process in the Options tab or 
use a User-Defined List of entities to process (section 4.4.2). 
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If the STEP File Analyzer crashes, you can also see which entity type caused the crash.  Figure 65 shows 
that the software crashed when processing an annotation_plane entity.  The entities of the type that 
caused a crash should be checked for syntax errors. 
 
Another way to prevent that entity type from being processed is to deselect, in the Process section of the 
Options tab, the category of entity that contains the entity that caused the crash.  That will prevent that 
entity from being processed along with all other entities of that category. 
 

 
 

Figure 65: Which entity caused a crash 
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10 Command-line Version 
 
A command-line (console) version of the STEP File Analyzer is available (sfa-cl.exe) that can be run 
from a Windows command prompt.  You must run the graphical user interface (GUI) version first before 
running the command-line version.  This version of the program can be accessed by or embedded in other 
programs.  The command-line version will use the options that were last used in the GUI version.  When 
the command-line version is run, feedback is provided that is similar to what is shown in the Status tab 
(section 4.3) as shown in Figure 66. 
 

 
 

Figure 66: Command-line version 
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To facilitate running the command-line version, the PATH environment variable can be set to include the 
directory where the command-line executables are located.  A batch file can also be created to run the 
command-line executable.  If the STEP file is not located in the same directory as the command-line 
executable, then the STEP file name should also include the directory pathname for the file.     
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